-

5 ouTtpPuTs

Part 4 explained the process of loading and submitting test data for analysis. Using the
test data set portrayed in Part 4, lets run through an example output. In this test data set,
we wish to test all variables from Sites TRA302, TRA307 and TRA311. Selection of

these sites gives the following display:

AUSRIVAS act-testdata-autumn_spring_combined-nffle.csv

5.1 What are the outputs?

Submission of these three sites for analysis brings up the following output. Each
variable is displayed on a separate tab. The user can peruse different variables by

clicking on the required tab. Note that the output creates a new window.
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AUSRIVAS act-autumn_spring_combined-nffle

Output tabs for each variable

EROS
Drata Count

Note creation of new window

In addition to the tab for each variable, the output also includes tabs that detail data
count, unused variables and out of range variables. Each component of the output will

be explained in the following sections.

51.1 Continuous variable tabs

The output of any continuous variable is a boxplot, calculated using the reference site
data. The test site values are then arrayed on to this box plot. Note that all three test
sites selected for analysis are arrayed onto the plot. Thus, it is important to limit the
number of sites tested in any analysis to 5-10, so that plot symbols can be viewed

accurately. Information on the interpretation of box plots is provided in Part 6.

Four box plots are presented on the x axis of this example. The ACT combined riffle
AUSRIVAS model contains three classification groups, and a box plot is presented for
each of these. A box plot is also presented for all the sites included in the ACT
combined riffle model, regardless of classification group. The y axis details the units of

measurement and the scale.
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act-autumn_spring_combined-riffle M= R

REAL Data Court
EROS

Units and
scale

By classificationgroup % 1 For all sites

5.1.2 Categorical variable tabs

The output for any categorical variable consists of three components. The first is a
frequency table, calculated using the reference site data. This frequency table displays
the number of reference sites in each classification group that belong to each data
category. It also displays the total number of reference sites that belong to each data
category. The second component displays the data category recorded at each selected
test site. The third component explains the data categories. Information on the

interpretation of frequency tables is provided in Part 6.

OUTPUTS 53



act-autumn_spring_combined-riffle HEER

Data Court

Local catchment erosion

Reference Data Set: Number of sites per category

Component 1

Group 1 / Frequency table
a1

Group 2

Group 3 16 | 1z

Total over all groups 30 | 38

Test Sites: Data Category for each site

Site TRA302 | 2 Test sites

Site TRA3OT

Lo TR A

act-autumn_spring_combined-riffle

1 B

Site TRA30Z

Site TRA3O7

Site TRA311

Category descriptions
gory P Component 3

none

same

moderate

heavy
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51.3 Data count tab

The data count tab details the number of REFERENCE SITES in each group, for each
variable. It also details the number of REFERENCE SITES that contain missing
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data (i.e a -999 value). The data count tab forms an important adjunct to the boxplots
and frequency tables because it is important to know the properties of the data that form
these outputs. For example, a classification group may have 24 members, but 12 of
these contain missing data for a particular variable. Thus, the user must decide whether
a box plot or frequency table created from only 50% of sites in that classification group
is valid. Information on missing data in a reference data set is provided in Section

7.2.1.1.

act-autumn_gpring_combined-riffle

EROS
Data Count

Total over all groups 75 i}

Local catchment erosion

Number of sites

Reference Site Group

Total | With Missing Data
Group 1 31 u]
Group 2 14 u]
Group 3 20 0
Tatal aver all groups 75 u]

Reach sand cover

Mumber of sites

Reference Site Group
Total | With Missing Data

Group 1 a1 0

Eﬁﬂ

51.4 Unused variables tab

In the present example, the unused variables tab does not appear because all the selected
variables were present in the reference data set. However, in cases where test site
variables do not appear in the reference data set, these are returned on the unused
variables tab. As mentioned in Section 3.2.4, it is not a problem to include additional
variables in the test data set. However, variables returned onto the unused variables tab
may indicate an error in entry of an acronym and should be checked accordingly (see

Section 5.1.6 common errors). The unused variables tab resembles the following:
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act-autumn_zpring_combined-riffle
Data Count ]

The following test data variables were not used. The variables RBS (relative
bed stability) and BKSLP

Test sites: Unused variables

RBS

BKSLP «@— | (bank slope) are not present
Possible reasons include in the reference data set and
can't be analysed

1. The variable code is incorrect;
2. The variable is not used in the selected model;
3. A data column was selected that doesn't contain variable data.

This page last modified at 2001-07-20 13:55:59 AUS Eastern Standard Time
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5.1.5 Out of range variables tab

In the present example, the out of range variables tab does not appear. However, in
cases where the entered value of any variable is outside the expected range, these cells
are returned to the out of range variables tab. These out of range variables are
included in the boxplots and frequency table outputs, so it is important for the user
to check the test data set if the out of range variables tab appears. Values should
then be corrected in the test data set and resubmitted for analysis. Further
information on the setting of valid ranges on the reference variables information sheet is

provided in Section 7.3.
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act-autumn_spring_combined-riffle

RESA
BrkH
Data Count

REAL
PH
Warning: Data out of range

Warning: Test Data Out of Range

The following test site data are outside the expected range: ReaCh algae categorles
are 1-5. A category of
Test Data Variable Code | Test Site | Yalue | Expected Range 0 is an invalid entry.
REAL TRAZO3 u] 1:2:3:4:5
HSCO TRAZO3 155 ==0:<=135 ( The USEPA habltat
assessment score should
MOTE: These data are included in the results given. be between 1 and 135

This information is supplied as a warning to allow the detection of gross errars,

This page last modified at 2001-07-20 13:59:06 AUS Eastern Standard Time
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5.1.6 Common problems with outputs

Some problems that may be encountered in the outputs are detailed in the following

sections.

Analysis of missing data

Analysis of missing data cells in continuous variables (i.e. cells containing -999 values)
will result in skewed box plots. For example, analysis of turbidity at all sites is selected

as follows:
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AUSRIVAS act-testdata-autumn_zpring_combined-niffle.cev

BRGR

[N R N e e A S A A A R SR R VR N

And results in the following output, where data values are skewed to include the test site

value of -999 that occurs at site TRA312.

act-autumn_spring_combined-riffle

& - £ &

Skewed scale
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The solution is to only highlight cells without missing data, by holding down the
<CONRTOL> key and clicking on the cells required.

AUSRIVAS act-testdata-autumn_spring_combined-riffle.csvy

TURE | EROS

%]

LSRR NS A R R R e S R N L ARt

Error in acronym name

An error in any acronym name contained in the test data set will be returned to the
unused variables tab.

act-autumn_spring_combined-riffle

BRGR
Drata Court

Test sites: Unused variables
The following test data variahles were not used.
RES&MD
Possible reasons include
1. The wvariable code is incorrect;

2, The variable is not used in the selected model;
3. A data column was selected that doesn't contain variable data.

This page last modified at 2001-07-20 14:09:28 AUS Eastern Standard Time
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The solution is to check the acronym names used in the test data set against those in the
reference data set. This is done by viewing the reference variables information sheet.
The reference variables information sheet is accessed via the "View" menu (see also

Section 3.2.2).

Reference Variables Information Sheet : act-autumn_zpring_combined-riffle

Urit of ement Yariable type Decimal pl: : ion

1=¢10% ; 2=10-35% ; 3=35-65% : 4=6£5-90| Categorical

Reach bedrock cover % Continuous

=R Reach boulder cover

S[26 Reach clay cover The acronym for reach

A8 Feach cobble cover Sand cover Should be

FERI=N Reach detritus cover S

p— RESA not RESAND
S

Fieach gravel cover
Fieach maciophyte cover/ 1=¢10% ; 2=10-35% ; 3=35-65% : 4=65-90| Categorical
Reach moss cover 1=¢10% ; 2=10-35% : 3=35-65% : 4=£5-90| Categorical
Reach muckmud cover
Reach pelmﬂ\
Reach periphyton cover \
Reach sand cover }

Reach silt cover /

Riffle macropkyte cover

Reach filament]

=

Reach bedrock

Feach boulder ¢

Feach clay cov

Feach cobble ¢

Feach detritus

Feach gravel o

Feach macroph|

Reach moss cof

e

Continuous Reach muck./mi

2

Continuous
1 3=35-B5% Categorical

Continuous

Reach pebble of

jry
||
o~
=
=
@

Reach periphyt]

a3

Reach zand coy

a3

Continuous Reach silt covel

&

Continuous
1 3=35-E5% Categorical
1 3=35-E5% Categorical
Contituous

jary
||
~
iy
(=1
i

jary
||
~
iy
(=1
i

Riffle moss cover

o

Riffle muck/mud cover
RS Riffle pebble cover
SIESER Riffle periphyton cover

o

Contituous
1 2=10-38% ; 3=35-65% Categorical
Contituous

Riffle pebble co

jy
&

Riffle periphyton|

Ripariat width Riparian width

E)

o|l=|lolololo|lo|lo|loojo|jojo|jo|jo|jo|jo|o|jo| oo

o

Riffle zatd cowver Continuous

Riffle and covel -

Boxplots difficult to view

As discussed in Section 5.1.1, selection of more than 5-10 sites for analysis will result
in a boxplot that is difficult to view, because some symbols will be hidden behind

others.
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act-autumn_spring_combined-riffle

If the output is difficult to read, the solution is to submit fewer sites per analysis.

5.2 Saving and printing the outputs

The procedure for saving and printing outputs differs for continuous and categorical

variables. Each procedure will be detailed in the following sections.

5.21 Saving and printing outputs from continuous variables

To save or print the output of a continuous variable (i.e. graphs), the output needs to
first be saved as an encapsulated postscript (.eps) file. Each continuous variable output
is saved as a separate .eps file. Move to the tab that you wish to save and choose "Print

to file" from the "File" menu.
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act-autumn_spring_combined-riffle

2

A standard file browser is displayed. Find the location for the save. Type in the file
name (it is recommended that this name includes details of the sites analysed and the

variable) and choose the (*.eps) file type from the "Save as type" menu.

act-autumn_gpring_combined-riffle

Include site numbers
and variable name

Sites 302-307-311 CHAL

|

|

— —1

Encapsulated postscript files [* eps) =l
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This saved .eps format file can then be opened and printed in a number of applications,

as follows.

Graphics packages

The .eps file can be opened directly into graphics packages such as Paint Shop Pro or
Adobe Acrobat (not Acrobat reader). Another package that is useful for viewing .eps
files is GSView. This program (Version 3.6) is free and can be down loaded from the
Internet at:

http://www.ghostscript.com

¥:Paint Shop Pro

=3 ACT combined riffle test data analy |—

FE] ites 302-307-311 CHAL eps

3R || v | gen [mymi [N e | e | [9IBE RD

The print function of the graphics package is then used to print the file.
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Paint Shop Pro - [Sites 302-307-311 CHAL .eps [1:1] [Layer1]]

g_combined-riffle : Channel alleralion habilal score

Chrl+F

T T
Groep 2 Grevp 3

Microsoft Word or Powerpoint

The .eps file can be printed in Word and Powerpoint. However, the .eps file can not be
viewed in these packages because they do not 'know' how to display encapsulated
postscript files. To print a saved .eps file from Word or Powerpoint, first insert the file

as a picture:

Microsoft Word - Document]

|
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Microsoft Word - Documentl
I
EedRe femds-
[[roma 8 imes tewRoman l12 )
” d ) |= Inzert Picture

[ \
anytime ———\ o] MewSearch|

Note that the graph is not displayed as the preview. However, proceed to insert this file,

which will look similar to the following.

Microsoft Word - Documentl
|
IDEeE|RY | & Bt - | @,
=
e

L] A R T R R R R L O S D Oy
a

o o m}
Title:
(CMelissafpemodulefSoftware component'Sofhware manual/ACT combined riffle test data analysisiSites 302-307-31
Creator:
(BLT 2.4 Graph)
F revien:

Thiz EPS picture was not sawed
with a preview included in it
Comment:

Thiz EFS picture will print to a
FostScript printer, but not to
ather types of printers.

\ The .eps file sits within a word document as a
picture object.

F oL CE I B 4 v a2 g
i
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Use the print function of the package to print what you see on the screen. This will
allow the graph to be printed, because the package 'knows' how to read the inserted .eps
file.

” ailiTol ord - Document
85
-8

e

el

o

ponent’Sofhware manuallACT combined riffle test data analysisrSites 302-207-21

Fool Bl B v v a2 s

5.2.2 Saving and printing categorical variable outputs

To save or print the output of a categorical variable (i.e. frequency tables), the output
needs to first be saved as either a Hyper Text Markup Language (.html) or a comma
delimited (.csv) file. Each categorical variable output is saved as a separate file. Move

to the tab that you wish to save and choose "Save" from the "File" menu.
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act-autumn_spring_combined-riffle _ =] x]

Data Count

chment erosion

Reference Data Set: Number of sites per category

Group 1

Group 2 a1

Group 3 16 |13

Total over all groups 30 | 38

Test Sites: Data Category for each site

Site TRA3DZ | 2

Site TRA3O7

A standard file browser is displayed. Find the location for the save. Type in the file
name (it is recommended that this name includes details of the sites analysed and the
variable) and choose the required file type from the "Save as type" menu.

act-autumn_zpring_combined-riffle =] x]

Data Count

Local catchment erosion

Reference Data Set: Number of sites per category

Save As

Group 1 3 ACT combined riffle test data analy |_

Group 2

Group 3 i Include site numbers
Total over all groups and variable name

Test Sites: Data Categ

site 302-307-311 EROS
Site TRAIND Comma delimited test [7 cav) r

Site TRA3O7
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The saved .html or .csv file can then be opened and printed as follows.

.CSV Files

The .csv file can be opened and viewed in Excel (or a similar spread sheet package).

Microsoft Excel - Book1

= Eaia 100%

Category frequency repart (Created by AUSRIVAS Phys/Chem Reparting Software version 1.0 2001-07-20 14:43:21 ALS Eastemn

Reference Site Graup Categary 1 (none) Category 2 (some) Categaory 3 (rmoderate) Category 4 (heavy)
Group 1 7 19 =3 1]
Group 2 7 |5 1 1]
Group 3 16 13 1 1]
Total over all groups 30 34 7 1]
Test Site Category 1 (none) Category 2 (some) Category 3 (rmoderate)  Category 4 (heavy)
TRA3D2 1

TRA3D? 1

TRA3N 1

6 7o12_hpdaon

%
x
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HTML Files

The .html files can be opened in an Internet browser.

t HOME - Netscape

Crl+0

Feil el SeleCt ChOOSe
file to browse

Open Page

_

3 ACT combined riffle test data analy ’((_

site 302-307-311 EROS hitm
HTHL Files ki :
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Files are displayed in the browser in the same format as the output tab.

Category frequency report - Netzcape

re component!Softwars matual/ACT combined riffle test data analysis/site 302-307-311 EROS htr |_| al

Local catchment erosion

Reference Data Set: Number of sites per category

Group 1 7 19 |5 |0
Group 2 7 o] 1|0
Group 3 16 |13 |1 |O
Total over all groups 30 {38 |7 |0

Test Sites: Data Category for each site

The print function of the Internet browser is then used to print the output.

5.2.3 Saving and printing outputs of other tabs

The data count, unused variables and out of range tabs are saved in the same way as any

categorical variable output (i.e. as a .csv or .html file).
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